
 With Easter already  behind us for another year I realize it is only a short  two months 
until the end of the financial year and our AGM will then follow in July. Your chance to 
Help!! 
WE REALLY NEED YOUR HELP NOW! 
Our committee is certainly a wonderful group of dedicated volunteers but I am sure I 
speak for every member of the committee when I say we would like to see some of our 
other members accept a position on the committee to allow some rotation of officers to 
take place. The duties and responsibilities of any member of the executive and manage-

ment committee of your club are not very demanding or time consuming but are essential roles within the 
club to enable it to continue to function and provide a great service to our fellow senior members of Gal-
ston and surrounding districts. Putting something back into your community, by helping others become 
more comfortable with today’s world of computers, digital photography and computerized services, is a 
very worthwhile service. So please do not be shy or afraid to step forward and offer to take on a position 
on the committee. 
WHY NOT TRY YOUR HAND AS A TUTOR. 
We would also like to have a few more volunteers to take on the role of tutor. You need not be an expert 
in all things or anything in particular. As long as you have a little patience, enough knowledge to start up 
the computer, work with a program you are familiar with and shut the computer down, you have enough knowledge to help a beginner 
get started with their computer. 
 

BROWSING THE INTERNET: 
I am always on the lookout for interesting Web Sites which are fairly easy to use and may be of interest to those who are just starting 
to use the internet.  We all like to dream a little from time to time, so holiday and travel sites can often be an interesting way to gain 
experience using web sites. 
WEB SITES WORTH CHECKING OUT. 
www.travelmate.com.au   Use the mapping feature for driving directions, map and things to see. 
www.totaltravel.com.au    An interesting site worth a serious look. 
www.lastminute.com.au    This site covers, holidays, accommodation, flights, car hire, etc. 
www.wotif.com/                  A favorite of mine, for finding accommodation on east coast trips. 
If you have an interest in GENEALOGY WITHIN N.S.W. the following sites may be worth a look. 
www.records.nsw.gov.au   Convict arrivals, colonial secretary papers, lots of old records 
www.bdm.nsw.gov.au        Go to family history section to search indexes 
www.cemindex.arkangles.com Over 200 small NSW Cemeteries . transcriptions and pictures 
www.genesreunited.com    Of help locating others researching your family. Membership A$20 
www.pictureaustralia.org/index.html  A vast collection of pictures of Australia’s days gone by. 
THE WEATHER is of interest, particularly when it rains 
www.bom.gov.au                Bureau of meteorology site. Satellite, radar images, tides, earthquakes. 
www.nasa.gov/                    Lots of information on space exploration 
If you are looking for a particular book and would like to know if your library has a copy (maybe at another branch) your local council 
website will usually have the library catalogue available to search by title or author. If they have the book you are looking for the 
search will reveal how many copies are held and at which branch and if they are available or on loan. 
LIBRARY SITES. 
www.hornsby.nsw.gov.au  From the Home page click on “Visit the Library” 
www.baulkhamhills.nsw.gov.au/library   
www.sl.nsw.gov.au/            The State Library in Sydney 
 

Don’t forget! 
Let  us know if you have a question you would like discussed at our workshop meeting 
 

Have fun with your computer! 
Lindsay McIntyre 
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Some interesting facts from Big-Pond  
 

Noticed an increase in spam lately?  No you are not imagining things!   
Spam has doubled over the past year.   In October 2005, it was estimated that spammers sent 31 bil-
lion unsolicited bulk emails every day.  
In December 2006, it was 61 billion – that is over 700,000 every second. 
 

As the world becomes cleverer at filtering spam with more advanced techniques, spammers  
become more creative in the techniques they use in an effort to fool spam filters and sneak past them to 
end up in your mailbox. The most successful technique they’ve found recently is 
image-based spam. 

REMINDER 

Hello everyone 
It is very good to see how many of you come to our Meeting-cum-workshops.  
I would love to hear more of you asking questions.  It does not matter how simple your 
question may be, we are there to help and encourage you. 
We have had a couple of new members since the last meeting.  They are  
Thelma and Roy Walker and Paul Chivers.  We hope they enjoy their time of learning with 
us and that they make some new friends who are also interested in improving their knowl-
edge of computers.  

 

The Next Meeting-cum-Workshop of 
 Computer Pals for Seniors, Galston & District will be held at 

History Cottage  412 Galston Road,  Galston 
 on Friday 27th April, 2007 

Time 10.30 am 
The Computers will be up and running for any questions or demos              

                                                                                  Rosemary 
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Word Questions and Answers 
How can I find out what the buttons on the toolbars do?   

Choose What's This? from the Help menu. The mouse pointer will turn into a pointer with a "?" symbol. 
Click on any button (or any other element or object on the screen) and Word will give you some informa-
tion. Also, Shift+F1 will turn on the What's This? feature. 
 

Can I turn the Ruler off (or turn it back on)?  
Choose Ruler from the View menu (if the Ruler is on, then you'll see a check next to Ruler). 
 

How can I display more toolbars?  

1.   Choose Toolbars from the View menu. 
2.   Select the toolbar you want (an active toolbar has a check next to its name).  

How do I move the toolbars?  

1.   Click on the left edge of the toolbar (the mouse pointer will turn into a four-headed pointer) 
2.   Drag the toolbar to any edge for a toolbar or anywhere else on the screen for a floating palette.  

DID  YOU  KNOW 
It is almost unbelievable to discover that, according to the Australian Securities and Investment 
Commission www.asic.gov.au/ , over 7,000 Australians have lost at least $500 million to financial scams 
in the past three years. Could you fall victim?  Do you know how to spot the clues? 
 www.asic.gov.au/fido/fido.nsf  Visit this page to find out about scams that aim to steal your identity; 
and there are also tips for retirees, and other useful pages on this website. 
For more information visit www.scamwatch.gov.au. To learn about more ways to protect your computer 
and your identity. 
To report a scam online visit www.fairtrading.nsw.gov.au or call 13 32 20. 



SKIP THE  RECYCLE  BIN 
Every now and then you need to really delete a file.   Well, most people delete the thing, then go to 
the recycle bin and remove it from there. It works, but there's a better way. 
Next time you  are 100% sure, without a doubt, for certain, that you want to delete a file, hold your 
Shift key down while you delete. The file will be deleted - skipping the Recycle Bin and is tossed into 
the digital abyss. 
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DID  YOU  KNOW 

 1.   The cruise liner QE2 moves only six inches for each gallon of diesel that it burns. 
 2.   Stewardesses is the longest word typed with only the left hand?  And lollipop with your right.  
 3.   No word in the English language rhymes with month, orange, silver or purple. 
 4.   Dreamt is the only English word that ends in the letters MT. 
 5.   Our eyes are always the same size from birth, and our nose and ears never stop growing. 
 6.   "The quick brown fox jumps over the lazy dog" uses every letter of the alphabet. 
 7.   The words racecar, kayak and level are the same whether they are read left to right or right to left. 
 8.   There are only four words in the English language that end in DOUS:  tremendous, horrendous,  
       stupendous and hazardous. 
 9.   Only two words in the English language have all five vowels in order, abstemious and facetious. 
10.  Typewriter is the longest word that can be made using the letters on only one row of the keyboard. 
11.  A shark is the only fish that can blink with both eyes, and a snail can sleep for three years. 
12.  An ostrich's eye is bigger than its brain? 
13.  In the last 4,000 years, no new animals have been domesticated. 
14.  If the population of China walked past you eight abreast, they say the line would never end because  
       of the rate of reproduction. 
15.  Rubber bands last longer when refrigerated. 
16.  The average person's left hand does 56 per cent of the typing. 

NEW STYLE FRUIT CAKE 
 

INGREDIENTS  
1½ cups brasil nuts - 8oz.                                         1 teaspoon vanilla 
1½ cups walnut halves. - 6 ozs                                 ½ cup red cherries 
¾ cup caster sugar                                                   ½ cup green cherries 
½ lb stoned dates                                                     ½ cup seeded raisins 
3 eggs                                                                      ¾ cup plain flour 
Pinch Salt                                                                 ½ teaspoon baking power 

� cup chopped candied peel - 4 ozs  
 

METHOD 
1. Grease sides and base of large loaf tin (8'' x5''). 
2. Line with 1 layer of glad bake paper. 
3. Place unchopped Brazil nuts, walnuts, dates, peel, cherries and raisins in a large bowl 
4. Sift together flour, baking powder and salt, then mix with sugar, add to fruit and nuts. Mix thoroughly . 
5. Make into stiff mixture with beaten eggs and vanilla. 
6. Spoon into prepared tin. Flatten top with back of spoon. 
7. Bake in slow oven 2 hours at 300.    Leave in tin  10 minutes, loosen edges, turn onto cake cooler 
8. Remove paper and when cold, wrap and store in refrigerator. 

Get ready for WINDOWS VISTA:  
Do you want to see if your Windows XP-based PC can run Windows Vista? Just download, install, and run the 
Windows Vista Upgrade Advisor. This small software tool will scan your computer and create an easy-to-
understand report of all known system, device, and program compatibility issues, and recommend ways to re-
solve them. 
 

Upgrade Advisor can also help you choose the edition of Windows Vista that best fits the way you want to use 
your computer: http://www.microsoft.com/windowsvista/getready/  
 

The Windows Vista Upgrade Advisor works with 32-bit versions of Windows XP and Windows Vista. It will not 
work with Windows 98, Windows 2000, or Windows XP Professional x64 Edition 
.upgradeadvisor/default.mspx 
 

The Windows Vista Upgrade Advisor does not collect or send any personal, identifiable data to Microsoft Cor-
poration or third parties 



Question and Answer 
Q.  When I am downloading information 
on to my computer from the internet, ie 
updating virus checking, downloading 
free programmes etc – do I have to wait 
until the downloading is complete, or can 
I continue using the computer? 
A.  You can continue using your com-
puter.  Just keep an eye on the progress 
which shows in your Task Bar. 
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Hearing Aids  
An elderly gentleman had serious hearing problems for a number of years. He went to the doctor and the 
doctor was able to have him fitted for a set of hearing aids that allowed the gentleman to hear 100%. The 
elderly gentleman went back in a month to the doctor and the doctor said, "Your hearing is perfect. Your 
family must be really pleased that you can hear again." The gentleman replied, "Oh, I haven't told my fam-
ily yet. I just sit around and listen to the conversations. I've changed my will three times!"  

Editor:  Rosemary Ansley 
Phone:  9651 2175     
E-mail gransy@tpg.com.au 

Computer Jargon 
 

The Scroll Bar To scroll something is to move it up or down the screen, so you can see what is 
above or below the current position, for example at a website. A scroll-bar is a bar on the right-
hand side (usually) of a window which allows you to move the text etc up and down the screen 
with a mouse. If the window is too wide to fit the screen there will be a scroll-bar at the bottom, so 
you can scroll the text left and right too. 
 
Taskbar In Windows, is a bar across the bottom of the screen (usually - you can move it to the 
top or side if you want to) which contains the Start Button, the System Tray, and icons which 
represent all the applications currently running. You can switch between applications by calling up 
the taskbar and clicking on the relevant icon. The taskbar can be set to remain visible all the time 
(the default), or only to appear when you press the Windows key. 
 
Uninstall  To remove a program from your system. You can't just delete its folder, because al-
most all programs make changes to various parts of Windows. Many programs come with a spe-
cial uninstaller, which you should use if it exists. Otherwise, you can uninstall programs (in Win-
dows) from the Control Panel. 

The Next Meeting-cum-Workshop of 
 Computer Pals for Seniors, Galston & District  

Will be held at  
History Cottage  

412 Galston Road,  Galston 
 Friday 27th April, 2007 

   Time 10.30 am 
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